
                                   
Read Me

Pro Tools LE 6.8.1 on Windows XP

This Read Me documents compatibility details, known issues, and guide addenda for Pro Tools LE 6.8.1 for Mbox 2 systems 
on Digidesign-qualified versions of Windows XP. For the latest compatibility information, visit the Digidesign Web site 
(www.digidesign.com/compato). 

Windows Configuration

Disable Data Executive Prevention (DEP)

When using Pro Tools, Data Execute Prevention should be disabled to prevent system crashes.

To disable Data Executive Prevention: (DEP)

1  Choose Start > Control Panel.

2  Launch System.

3  Click the Advanced tab.

4  From the Startup and Recovery section, click Settings.

5  Click on the down arrow in the Default Operating System pop-up menu, and note if the “/NoExecute=” line reads as fol-
lows:

/NoExecute=AlwaysOff

6  Do one of the following:

• If the “/NoExecute=” reads “/NoExecute=AlwaysOff,” data prevention is disabled, and you do not need to change any 
settings. Click OK to close the Startup and Recovery dialog, click OK to close the Systems Property dialog, and skip the 
following steps.

– or –

• If the “/No Execute=” does not read “/NoExecute=AlwaysOff” (for example, it reads “NoExecute=OptIn”), continue with 
the following steps.

7  Click Edit to edit the startup options file manually

8  Change the “/NoExecute=” line to read as follows:

/NoExecute=AlwaysOff

9  Save the boot.ini file if it was changed.

10  Choose File > Exit.

11  From the Startup and Recovery dialog, click OK.

12  From the System Properties dialog, click OK.

13  Restart the computer. 
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Compatability

Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations. 
For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the latest compatibility in-
formation on the Digidesign Web site (www.digidesign.com).

Setting Up Pro Tools LE Hardware with Windows Before Installing Software

After installing your hardware and starting up your computer, wait for the Found New Hardware Wizard dialog to appear and 
leave it open. Leave the Wizard on-screen, and place the Pro Tools LE Installer CD-ROM for Windows into your CD-ROM 
drive. Locate the Setup icon (in the Pro Tools LE Installer folder) and double-click the icon. To avoid installation problems, 
please read carefully and follow the installation instructions in your Getting Started Guide.

Opening Mixed Audio Format TDM Sessions on LE Systems

Because Pro Tools LE does not support “mixed audio file format” sessions created on a Pro Tools TDM system, TDM users 
must first use Save Session Copy In to create a copies of all audio files in a single format before they can be opened on an LE 
system.

Transferring Sessions with Plug-Ins Between TDM and LE Systems

When transferring sessions between LE and TDM systems, plug-in settings should be copied to the session's Plug-In settings 
folder. This helps restore the proper plug-in preset names.

Known Issues
The following sections document known issues you may encounter when using Pro Tools LE 6.8.1, along with workarounds 
if they exist.

MIDI Driver Doesn't Load when Mbox 2 is not Turned On Before Launch (Item #58691)

In order for the MIDI driver to load, Mbox 2 needs to be connected before launching Pro Tools. If Pro Tools is launched with-
out Mbox 2, a dialog will appear to connect a missing hardware. Pro Tools will successfully launch afterwards but the MIDI 
driver will not load.

EQ III Plug-Ins are Inactive when Opening a TDM Session (Item# 62302)

Save the presets from the TDM system and import it to an Mbox 2 system.

Mbox 2 does not Support Sample Rates of 49KHz or Above (Item #63141)

Mbox 2 does not support sample rates of 49KHz or above due to the bandwidth limitations of USB 1.1 and the USB Control-
ler. This is only an issue when syncing to an external S/PDIF clock that is pulled up 2% or more above a nominal 48KHz sam-
ple rate.

Waveforms Fail to Display During Long Recordings (Item #60719)

When making a long record pass, the waveforms may stop drawing after 20 to 30 minutes. The overviews are calculated after 
the session is re-opened.

Unnecessary Automation Breakpoints Added to Grouped Audio and MIDI Tracks When Using the Triangle Pencil Tool 
(Item #59233)

When MIDI and Audio tracks are grouped and automation is added using the Triangle Pencil tool, several thousands of un-
necessary automation breakpoints are added. To remove any unwanted automation breakpoints, highlight the desired area 
in the Edit window and select Edit > Thin Automation.
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Bluescreen on Pro Tools Launch (Item: #57561) 

If Pro Tools installation and relaunch results in a bluescreen, try updating the PACE driver with the newest installer available 
at the Pace Web site.

Scrub Does Not Work when Input Only Monitor Mode Is Active and A Track Is Armed (Item #59380)

When Input Only Monitor mode is active and another track is armed, tracks will not scrub.

Pro Tools 6.8.1 Information Is Lost When Saving a Session in an Earlier Version of Pro Tools (Item #49923)

Color coding, Tick-based tracks, and marker comments are lost without warning when a session that is saved in Pro Tools 
6.8.1 is opened in any version of Pro Tools earlier than 6.7, or when you save the session in an earlier Pro Tools format using 
the Save Session Copy In command.

Accessing Playback Engine after Opening a Recovered Session (Item #54319)

A recovered session from the “Session File Backups” folder must first be saved with a new session name before it is possible 
to access the Playback Engine Dialog.

Destructive Processing with AudioSuite Plug-Ins (Item #50454)

Performing destructive file processing with AudioSute plug-ins while logged into a non-administrative account may cause the 
following error: “Could not complete your request because the system cannot find the file specified (2).” 

This is probably because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to 
the audio file. 

If you do not have administrative access of the computer then you must either contact the administrator of the computer to 
resolve this problem, or use the Save Session Copy As feature of Pro Tools to create a copy of the session with all of its audio 
files.

Locking Audio Files Within the Workspace Browser While Logged into a Non-Administrative Account (Item #50457)

When Locking your audio files within the workspace window while logged into a non-administrative account may cause the 
following error in the task window of Pro Tools: “Could not complete your request because the system cannot find the file 
specified (2).” 

This is probably because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to 
the audio file. 

If you do not have administrative access of the computer, then you must either contact the administrator of the computer 
to resolve this problem, or use the Save Session Copy As feature of Pro Tools to create a copy of the session with all of its audio 
files.

Bouncing to Disk While Logged into a Non-Administrative Account (Item #50488)

Bouncing to disk to the root level of any SCSI drive while logged into a non-administrative account may cause the following 
error: “Could not complete the bounce to disk command because Access is denied.” This is because Windows XP doesn't al-
low files to be created at Root level of a drive while logged into a non-administrative account. To get around this problem, 
you must create a sub-directory and redirect your session bounce to the newly created directory. 

Recalculating Overviews While Logged into a Non-Administrative Account (Item #50537)

Recalculating overviews of audio files while logged into a non-administrative account may cause the following error in the 
task window in Pro Tools: “Access denied. (5).” This is probably caused by the audio files having read-only permissions. 

In order to correct this, you must be able to log into an administrative account in Windows XP and change the permissions 
of the audio file so you have full access to the audio file. 
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If you do not have administrative access of the computer then you must either contact the administrator of the computer to 
resolve this problem, or use the Save Session Copy As feature of Pro Tools to create a copy of the session with all of its audio 
files.

Performing Commands Which Require Saving a Session on a Non-Administrative Account (Item #53335)

When logged in as non-administrative user, and opening a session which was copied from CD-ROM (or external hard drive) 
onto the system, executing any command which causes Pro Tools to save the session will cause the Access to be denied. To 
resolve this problem, first save the session with Save As or Save Session Copy In.

Opening a Pop-Up Window or Menu Over a QuickTime Movie Crashes Pro Tools (Item #54237)

Opening a pop-up window or menu over a QuickTime video crashes Pro Tools. Keep QuickTime videos out of the way of pop-
ups and menus that you intend to repeatedly open and access.

Pro Tools Unable to Relink to Audio Files and Fade Files That Have Illegal Characters when Enforce Mac/PC Compatibility 
Not Enabled (Item #60728)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without 
the Enable Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually 
relink each file by File ID.

I/O Setup Files Can Be Saved with Illegal Characters when Enforce Mac/PC Compatibility Option Not Enabled 
(Item #60730)

When importing I/O Setup files (.pio files) from Macintosh sessions that were not saved with the Enable Mac/PC Compati-
bility option enabled, files that have illegal characters are not converted successfully—illegal characters do not get replaced 
with an underscore.

Unable to Open Macintosh Sessions from Workspace if Title’s Illegal Characters Were Converted to Underscore Symbol 
(Item #60243)

You will not be able to open a Macintosh session from the Workspace if the session name contains illegal characters that were 
converted to underscore. The workaround is to open the session with File > Open Session.

Mac/PC Compatibility (Item #54395)

On Windows XP, trying to open a Mac session (that was saved with Mac to PC compatibility checked) directly from a HFS+  
drive will result in an error dialog stating that the session must be on an audio record volume. 

In order to mount a Mac (HFS+) volume on an XP system using MacDrive or MacOpener and then open a Mac/PC Pro Tools 
compatible session from the drive, you must first copy the session to a local PC drive (it is not necessary to copy over the au-
dio files). From the local Windows compatible drive, you can open and run the session.

Groove Templates (Item #43997)

Users will be unable to retrieve their custom-made groove templates that are saved in an incorrect directory. Groove Tem-
plates should be saved only within the “Grooves” folder.

Using the WaveDriver with Quicktime Player (Item #52540)

It is not recommended to use the WaveDriver with the Quicktime player. There is the possibility that the audio on certain 
Quicktime movies will drift out of sync, or drop out when playing back Quicktime movies with the Quicktime player while 
using the Wave driver as its output device.

Uninstalling Cubase SX Prevents Pro Tools Driver Installer From Working (Item #48450)

If the Pro Tools installation gets disrupted by a dialog “The driver installer could not find the driver information. Please make 
sure the path to the INF file is correct,” there is a possibility that a Cubase uninstall has occurred prior to installation of 
Pro Tools. Reinstall Cubase SX before installing Pro Tools.
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Importing Tracks with Import Session Data Clears the Undo Queue (Item #51775)

It is documented in the Reference Guide that importing tracks through Import Session Data clears all the undo queue. The 
undo queue gets cleared when Main Playlist Options is set to “Import, Replace existing playlists.” The undo queue does not 
get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”

Intermittent Shuttle Lock Commands Ignored (Item #47155)

Shuttle Lock commands occasionally seem to be ignored. Click once on the Transport pop-up and the functionality will re-
turn.

Using Hyphens as Part of a Track Name Causes Auto-Naming Problems (Item #36223) 

If you have an audio track with a name that includes a “-” (such as “Mixdown-Full”), any audio file recorded on that track 
will not preserve the part of the name that follows the dash. For example, a track named “Mixdown-Full” will auto-name the 
recorded audio file “Mixdown.”

File Management

Lost Data when Burning Sessions to DVDr (Item #59227)

When doing a session data backup to a DVDr with the MacDrive6 DVD/CD burning utility, it is possible that session data on 
the DVDr will be lost.

System Crash on Startup with Macintosh Formatted FireWire Drives (Item #45288)

After installing MacDrive, mount Macintosh formatted FireWire drives only after Windows has finished starting up. Starting 
up with FireWire drives connected immediately after installing MacDrive without letting the system restart completely causes 
a system crash. 

Disk Management when Using Macintosh Formatted Drives (Item #45459)

You must disable the MacDrive service in order to convert or re-format an HFS+ FireWire drive to NTFS format.

Loss of Sharing Information when Unmounting Drive from Pro Tools Workspace (Item #46273)

Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is 
unmounted from within a Pro Tools workspace. 

Sluggish Performance when a Mapped Network Drive Becomes Unavailable (Item #44420)

When using Pro Tools, make sure all mapped networks are present and available. If your computer is mapped to a network 
drive that becomes unavailable, Pro Tools may become sluggish. 

Missing Files when Opening a Session Created by an Earlier Version of Pro Tools (Item #37572)

When opening some sessions created by an older version of Pro Tools, some files may be missing. You should be able to relink 
these files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.

MIDI

Inconsistent MIDI Performance on Dutch OS with English Pro Tools LE (Item #59608)

When running the English version of Pro Tools LE on Dutch OS, MIDI output can slow down with extended use.

Software Instruments Keep Playing after Half-Speed Playback Is Stopped (Item #54807)

Occasionally, software instruments keep playing even after playback is stopped. This problem occurs after choosing the half-
speed playback mode. To reset the MIDI notes, open the Playback Engine dialog and immediately click OK to close it, or 
choose MIDI > All Notes Off. 
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Plugging or Unplugging a USB MIDI Interface Causes Pro Tools to Fail (Item #50136, 48445 and 48446)

Pro Tools does not support hot plugging or unplugging of USB MIDI interfaces. Attach your MIDI interface to your computer 
before launching Pro Tools, and quit Pro Tools before unplugging the MIDI interface.

Pro Tools UI Gets Sluggish While Recording MIDI (Item #52815)

During lengthy MIDI record passes, the Pro Tools user interface can begin to feel sluggish when the MIDI Event List is open. 
Close the MIDI Event List window during extended or heavy MIDI record passes.

Only 32 Emulated MIDI Inputs Appear in Pro Tools (Item #53224)

Windows XP has a 32 MIDI port (input or output) limit for Emulated MIDI devices. If you are using devices which are non-
timestamped (Emulated), only the first 32 Emulated inputs and Emulated outputs will appear as selectable in your MIDI ap-
plication.   

MIDI Inputs and Output Seem to be Missing from the Screen, or Appear to Scroll off Screen (Item #53611)

When the screen resolution is set to 1024x768, users with large MIDI configurations might notice MIDI inputs/outputs miss-
ing from the MIDI input/output routing pop-up dialogs. Resize the screen to a higher resolution to resolve this problem.

Plug-Ins

Song Position Pointer Messages Are Not Received in “Continuous Scroll with Playhead” Mode (Item #54587)

When in “Continuous Scroll with Playhead” mode, Synchronic, Intakt (Native Instruments) and other MIDI-enabled plug-
ins stop receiving Song Position Pointer messages and cannot catch up when toggling/priming playback.

MIDI Outputs to Software Synthesizer Plug-Ins Are Italicized in Cross-Platform Sessions (Item #54173)

MIDI output ports show up italicized when opening a session on a different computer platform than the session was created 
on until you re-assign the outputs.

Plug-Ins Patch Window with RAM-Based Samplers and Software Synthesizers (Item #53245/53314)

Synchronic and other RAM–based software instruments make a “hiccup” sound when you exit out of the plug-in patch Win-
dow by pressing “Cancel.” Additionally, the plug-in patches will be forced to re-load the existing sound when previewing 
sounds within the plug-in Patch window. 

Expired Demo Plug-Ins

Using a demo plug-in whose trial period has ended may result in an “Illegal Instruction Attempted” error within Pro Tools LE. 
Removing the expired demo plug-ins from your Plug-In folder will rectify the situation.

Pace InterLok Plug-In Authorization Lost in NTFS Boot Drives with Long Names

If your system contains one or more drive(s) formatted with NTFS, and which have drive names longer than 11 characters, 
corruption of InterLok Plug-In authorizations may occur. In order to remedy this issue before corruption can occur, rename 
NTFS volumes to drive names that are 11 characters or less before installing or launching Pro Tools LE. Should you attempt 
to launch Pro Tools LE with NTFS drives longer than 11 characters, a dialog should appear alerting you to this fact.

Mod Delay II Plug-In Delay Time

After a Duration (note value) has been set in the Mod Delay II window, changing the Delay time using a control surface (such 
as Digidesign’s Control|24) will not deselect the Duration parameter. Changing the Delay time control in the plug-in window 
will work correctly.
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Mod Delay Plug-In and Automation Data

Mod Delay cannot have automation data copied and pasted to the adjacent left or right audio channel, even when the au-
tomation data is to or from the same control. For example, Feedback Left automation data cannot be copied to Feedback 
Right.

To apply automation data to both the left and right channels of the Mod Delay stereo outputs, use multi-mono plug-ins in 
place of the stereo or mono-to-stereo Mod Delay. Multi-mono plug-ins allow automation to be linked, thereby providing the 
same automation data to all linked channels.

Severe Latency with MIDI Beat Clock when Using DigiRack ReWire (Item #35457)

If MIDI Beat Clock data is sent from Pro Tools to a ReWire client, extreme latency may be heard when using a MIDI Keyboard 
to trigger the ReWire client. It is recommended that you do not route MIDI Beat Clock data from Pro Tools to a ReWire client .

AudioSuite Signal Generator Does Not Process (Item #35900) 

The AudioSuite Signal Generator plug-in defaults to “Create Individual Files.” If you make a selection in the timeline that 
does not contain audio, you will need to select “Create Continuous File,” or you will encounter a dialog warning you that no 
audio is selected.

Signal Generator Pink Noise

The Signal Generator plug-in has an improved pink noise signal output that makes Signal Generator appropriate for room cal-
ibration and similar applications. This pink noise output level is much higher than in versions prior to version 5.3 of Signal 
Generator. To avoid audible distortion while running pink noise, set the Signal Generator volume slider to –12 dB to avoid 
clipping.

Pitch Shift AudioSuite Plug-In

When batch processing several stereo or multi-mono files in the Regions List using the AudioSuite Pitch Shift plug-in with 
time correction turned off, the right channel of each resulting file after the first is random audio or white noise. If using the 
AudioSuite Pitch Shift plug-in, process each stereo or multi-mono file individually, or split the files into individual mono files 
prior to batch processing.

AudioSuite Processing and Side Chain Inputs

Side chain inputs for plug-ins (such as Compressor and Limiter) have no effect on AudioSuite processes when the Selection 
Reference is set to Region List.

Video

Bounce to Movie While Converting Sample Rate Creates White Frames in Quicktime Movies (Item #54220)

While bouncing audio to a Quicktime movie it is not possible to convert the sample rate of the audio during the bounce with-
out compromising the video/audio synchronization. Bounce audio and convert it to the correct sample rate first, and then 
import this audio into another session created at the appropriate sample rate. Import the audio and the movie and then 
bounce to create a new movie.

Unable to Scrub QuickTime Movie (Item #36509) 

After re-linking to a QuickTime DV movie, you will not be able to scrub the movie. To be able to scrub the QuickTime movie, 
you will have to Save the session, quit Pro Tools, and then re-launch Pro Tools and open the session.

Unable to Maintain Original Time Code Locations (Item #37628)

(DV Toolkit for Pro Tools LE Only)

When redefining time code, Pro Tools may incorrectly report that it is “unable to maintain original time code locations with 
the entered start time because a region or an alternate playlist would exist outside the session boundaries. Click OK to main-
tain relative time code.” If you click OK, the time code will be remapped properly.
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General Localization 

No Double-Byte Character Entry in Browser When Mac/PC Mode Is Enabled (Item #54387)

You cannot name files with double-byte characters in a browser window if Pro Tools is launched in Mac/PC enforced mode. 
To use double-byte characters, re-launch Pro Tools with Mac/PC mode disabled. 

Region Misnaming in Tracks That Contain Japanese Katakana Characters “So” and “Po” (Item #58140)

On tracks that contain the Japanese katakana characters “So” and “Po” in their names, recorded regions are erroneously 
named with katakana “Da” instead (in the place where there should be a “So” or “Po”).

Error Messages

Error –6031 During Playback (Item #32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the 
session, quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks 
to the appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.
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